
Figma for Beginners 

Learn Figma in 1 Hour — Complete Course Notes  

SECTION 1: Getting Started — Account, Teams & Projects 

1.1 Creating a Figma Account 

Figma is a browser-based (and desktop app) collaborative design tool. You can sign up at figma.com using 

Google or email. No software installation is required to run Figma in the browser.  

• Sign up at figma.com — choose Google sign-in or create an account with email 

• Fill in your name, role, and preferences during onboarding — you can skip the mailing list 

• A short tutorial pop-up appears on first login — you can dismiss it and explore freely 

• A free Starter plan is available — suitable for learning and solo projects 

• Professional plan is recommended once you start actively collaborating with a team 

 

1.2 Teams & Projects 

Figma organizes your work in a hierarchy: Team → Project → File. Understanding this structure helps you 

keep your design work organized from the start. 

• Team — the top-level workspace. Click 'New Team' on the left sidebar to create one. Teams can 

contain multiple collaborators. Example: 'Recipe Team' 

• Project — a folder within a team. Click 'Create Project' to add one. Example: 'Recipe App' 

• File — the actual design file you work in. Click 'New File' within a project to start designing.  

• Collaboration — you can invite collaborators to a team by entering their email addresses. They 

receive an invitation immediately. 

• Import — you can import existing design files into a project if you already have assets 

 

1.3 Navigating the Figma Interface 

Once you open or create a file, you enter the Figma editor. The interface is divided into five key areas:  

• Top Toolbar — contains the main menu, selection tools, frame tool (A), shape tools, pen tool (P), 

text tool (T), comments tool, share button, play/preview button, and zoom controls 

• Left Panel — shows Layers (the hierarchy of all elements on your canvas) or Assets (components 

and styles). Switch between them using the tabs at the top of the panel.  

• Canvas — the central workspace where you create and arrange your designs 

• Right Panel — contains three tabs: Design, Prototype, and Code. This is where you configure 

properties for selected elements. 

• Bottom Right — a question mark icon for quick access to help and resources 

 

 

 

 

 

 

 



1.4 The Three Right-Panel Tabs 

Tab Purpose 

Design Set visual properties: position, size, color fills, gradients, strokes, shadows, opacity, 
corner radius, and more. Primary tab for styling your elements. 

Prototype Make your design interactive. Connect screens with transitions, set triggers (tap, 
delay), choose animation types (dissolve, smart animate), and set overflow scrolling 
behavior. 

Code View the generated CSS, iOS, or Android code for any selected element. Useful for 
handing off designs to developers. 

  



SECTION 2: Frames, Shapes, and Text 

2.1 Frames (Artboards) 

A Frame in Figma is the foundational container for your designs — think of it as a blank sheet of paper or a 

phone screen on which you create your UI. 

• Press A on your keyboard to enter Frame mode 

• Preset options appear in the right panel (e.g. iPhone 8, iPad, Desktop, Custom) — click any preset 

to place a frame instantly 

• Or click and drag on the canvas to create a frame of any custom size 

• Rename a frame: double-click its name above the frame, or press Cmd/Ctrl + R 

• Hold Shift while resizing to constrain proportions (keep width and height ratio) 

• Navigate the canvas: hold Space + click-drag to pan; scroll to zoom 

 

2.2 Basic Shapes 

Figma provides several built-in shape tools accessible from the toolbar: 

• Rectangle — click and drag. Hold Shift to create a perfect square. 

• Ellipse/Circle — click and drag. Hold Shift to create a perfect circle. 

• Polygon, Star, Line — additional shape options in the shape tool dropdown 

• After drawing a shape, its properties (width, height, fill, stroke, corner radius) appear in the right 

Design panel 

 

2.3 Fills & Gradients 

Select any shape and use the Fill section in the Design panel to apply color or gradient: 

• Solid color — click the color swatch to open the color picker. Use the hex field for precise values. 

• Linear Gradient — click the fill type dropdown > select Linear. Drag gradient stops to set colors and 

positions. Each stop can have its own color and opacity. 

• Radial Gradient — emanates from a center point outward. Good for spherical or glowing effects. 

• Opacity — always check that gradient stops have the correct transparency set. Transparent ends 

(0% opacity) cause a fade-to-transparent effect. 

• Image Fill — fill a shape with an image from your computer (or use the Unsplashed plugin for easier 

image insertion) 

 

2.4 Strokes & Shadows 

• Stroke — adds an outline around a shape. Options: Inside, Outside, or Centre. Set width and color. 

• Drop Shadow / Inner Shadow — add depth to elements. Configure X offset, Y offset, blur radius, 

spread, and color. Reduce color opacity to make shadows subtle and professional. 

• Multiple fills, strokes, and shadows can be stacked on a single element 

 

 

 

 

 

 



 

2.5 Alignment Tools 

When one or more elements are selected, alignment controls appear at the top of the Design panel:  

• Left, Centre, Right — horizontal alignment 

• Top, Middle, Bottom — vertical alignment 

• Distribute — evenly spaces multiple selected elements horizontally or vertically  

• Multiple elements: Shift-click each to select them together, then apply alignment 

 

2.6 The Text Tool 

• Press T or click the text tool in the toolbar to create a text layer 

• Click anywhere on the canvas to create an auto-sizing text box (expands as you type) 

• Click and drag to create a fixed-width text box (text wraps to the next line automatically — useful for 

body copy in fixed containers) 

• Set font, weight, size, and alignment in the right Design panel 

• Quick size adjustment: select the size field, then hold Shift + Up/Down Arrow to change size in 

steps of 10 

• Center, left, or right align text using the alignment buttons in the panel  

• Note: centering only works as expected if the text box has a fixed width (click-drag creation). Auto-

sized boxes center relative to the text itself. 

 

2.7 Google Fonts 

Figma has direct access to the entire Google Fonts library — thousands of fonts available instantly with no 

download required. 

• Browse fonts at fonts.google.com to find the right typeface 

• Common font filters: category (Serif, Sans-Serif, Display, Monospace), number of styles, 

thickness/weight 

• To apply: select your text layer, click the font family field in the panel, type the font name, and press 

Enter 

• Recommended course fonts: Montserrat (logo, headers — bold and impactful), Open Sans (body 

text — legible at small sizes) 

  



SECTION 3: Boolean Operations, Layers & Grouping 

3.1 Boolean Operations 

Boolean operations let you combine two or more shapes into a single new shape. Select two shapes (Shift-

click to multi-select), then choose from the Boolean Operations dropdown in the top-right toolbar. 

Operation Effect 

Union Merges both shapes into one combined shape. The result takes the fill of the bottom 
layer. 

Subtract Removes the top shape from the bottom shape, creating a cutout. The bottom shape 
is the base. 

Intersect Keeps only the overlapping area of the two shapes. Everything outside the overlap is 
removed. 

Exclude Keeps everything EXCEPT the overlapping area — the inverse of Intersect. 

 

Key insight: even after applying a Boolean operation, the original child shapes are still accessible in the 
Layers panel. You can select them individually and move or resize them to fine-tune the result — without 

losing the non-destructive nature of the operation. 

 

3.2 The Layers Panel 

The Layers panel (left side) shows every element on your canvas in a hierarchical tree. Understanding it is 

essential for selecting, organizing, and managing complex designs. 

• Each shape, text box, group, frame, and component appears as a layer 

• Layers are ordered top-to-bottom in the panel = front-to-back on the canvas 

• Click a layer to select it; click the eye icon to hide it; click the lock icon to prevent accidental editing 

• Expand a group or component by clicking the arrow next to it  

• Elements with a purple four-square icon are master components 

• Elements with an empty tilted square icon are component instances 

 

3.3 Selecting Elements — Direct vs Group Selection 

• Clicking on an element selects its parent group by default 

• Hold Cmd (Mac) or Ctrl (Windows) while clicking to select the specific child element inside a group 

— a line appears beneath the element as a hint 

• This works for text, rectangles, images inside groups, and components 

• Double-click to enter edit mode for that specific element 

 

3.4 Grouping & Ungrouping 

• Select multiple elements > press Cmd/Ctrl + G to group them into a single layer 

• Right-click > Ungroup (or Cmd/Ctrl + Shift + G) to ungroup 

• Rename groups immediately for clarity — double-click the layer name in the Layers panel 

• Groups are useful for moving related elements together and for organizing the layer structure 

 



3.5 Layer Order — Moving Layers Forward/Backward 

• Cmd + [ (left square bracket) — move layer backward one position 

• Cmd + ] (right square bracket) — move layer forward one position 

• Or drag layers up/down in the Layers panel to reorder them 

• Use this to place background images behind foreground text and shapes 

  



SECTION 4: Material Icons, Plugins & Exporting 

4.1 Material Icons in Figma 

Figma has the Material Icons font built in, which gives you instant access to hundreds of standard UI icons 

(clock, people, back arrow, search, etc.) without importing any images. 

• Visit material.io/icons to browse all available icons and find the icon name 

• Create a text layer (press T), type the icon's underscore name (e.g. access_time, chevron_left, 

people) 

• Select the text and change the font family to Material Icons — the icon renders immediately in place 

of the text 

• Resize by adjusting the font size; recolor using the fill color controls like any text 

• This technique is used throughout the course for clock icons (access_time), people icons (people), 

and back-arrow navigation (chevron_left) 

 

4.2 Installing and Using Plugins 

Plugins dramatically extend Figma's capabilities. They are found and installed directly within the app:  

• Menu > Plugins > Manage Plugins > Browse Plugins — search for the plugin by name 

• Click Install to add it to your plugin library 

• To use: right-click any layer/element > Plugins > select the plugin 

• Or: Menu > Plugins > select the plugin from your installed list 

 

4.3 Unsplash Plugin 

The Unsplash plugin allows you to search and place high-quality, freely licensed photos from unsplash.com 

directly into any rectangle or shape in your design. 

• Ideal for placeholder images during prototyping (food photos, portraits, landscapes, etc.) 

• Select a rectangle > right-click > Plugins > Unsplash > search for a keyword (e.g. 'food') > click an 

image to apply 

• The image fills the shape automatically. Re-run the plugin to swap images. 

• Used in the course for: splash screen background, recipe list thumbnails, and recipe detail hero 

images 

• Occasionally the search may return unexpected results — simply run the search again 

 

4.4 Lorem Ipsum Plugin 

The Lorem Ipsum plugin by David Williams generates placeholder text to fill text layers during design. This 

avoids manually typing filler content. 

• Install via: Menu > Plugins > Manage Plugins > Browse Plugins > search 'lorem ipsum' 

• Select a text layer > right-click > Plugins > Lorem Ipsum 

• Choose between: generate multiple sentences (long paragraph), or auto-generate to fill the text 

frame 

• Note: make sure the text layer is not empty before running the plugin — Figma removes empty text 

layers automatically 

• After generating, reset the font to your chosen typeface (e.g. Open Sans, Regular, size 15) since 

the plugin may inherit the last used font 

• Used in the course for: recipe detail instructions text 



 

4.5 Exporting Assets 

Figma can export any selected element or frame as PNG, JPG, SVG, or PDF. 

• Select the element or frame you want to export 

• Scroll to the bottom of the Design panel > click the + next to Export 

• Choose: format (PNG/JPG/SVG/PDF), scale/magnification (1x, 2x, 3x for retina) 

• Click Export [item name] > choose save location 

 

IMPORTANT — transparent vs. white background: 

○ Selecting only an inner element (e.g. a logo group) and exporting gives a PNG with a transparent 
background 

○ To export with a white background, select the outer FRAME containing the element — the frame's fill 
color is included in the export 

○ Always check what is selected before exporting to avoid the wrong background 

  



SECTION 5: Information Architecture & Building the Recipe App 

5.1 What is Information Architecture? 

Before opening a design tool, great designers ask: what data am I working with? Information Architecture 
(IA) is the practice of planning and mapping the content and structure of your product before designing it 

visually. 

• IA answers: what screens does the app need? What data does each screen display? 

• Prevents over-designing — you only build what is actually needed 

• In the course, IA is done in a separate brainstorm Figma file using the text tool to list content  

 

Recipe App — Information Architecture: 

○ Screens: Splash Screen (app entry), Overview (list of recipes), Detail (single recipe view)  

○ Recipe data fields: Name, Time to cook, Amount of servings, Picture of food, Instructions 

○ Ingredients were noted but intentionally skipped for scope management 

 

5.2 Splash Screen 

The splash screen is the app's opening/loading screen. It introduces the app brand before the user enters 

the main content. 

• New artboard: press A > select iPhone 8 preset > rename frame to 'splash screen' 

• App name: 'SALT.' — chosen for its recipe/food connotations and visual simplicity 

• Font: Montserrat Bold, large size — bold and impactful for a logo/title treatment 

• Logo creation: type the app name in a text layer, draw a white square behind it (for legibility), group 

both (Cmd/Ctrl + G), move square behind text using Cmd + [ 

• Background: create a rectangle covering the full artboard, use the Unsplash plugin to fill it with a 

food photograph 

• Layer order: background image at the back, logo group in front. Use Cmd + [ to push the image 

layer backward. 

 

5.3 Overview Screen (Recipe List) 

The overview screen displays a scrollable list of recipes with images, names, cooking time icons, and 

serving icons. 

• New artboard: press A > iPhone 8 > rename to 'overview' 

• Header: create a white rectangle (height ~50px), add drop shadow (low opacity), add app name text 

at ~22px Montserrat 

• Recipe list item structure: 

○ Recipe name — text layer (recipe title) 

○ Time to cook — Material Icon (access_time) + text label (e.g. '5-10 minutes') 

○ Servings — Material Icon (people) + text label (e.g. '4 people') 

○ Food photo — rectangle filled with Unsplash food image 

○ Background card — white rectangle with subtle drop shadow behind all elements 

• Font for body text: Open Sans — more legible than Montserrat at smaller sizes 

• Icons: select both icon layers, set colour to grey, increase size to ~16px 

• Group the list item: select all elements > Cmd/Ctrl + G > name group 'list item' 

• Copy and paste the list item group to create multiple recipe entries and swap images via Unsplash 

plugin 



 

5.4 Detail Screen (Single Recipe) 

The detail screen shows the full information for a single selected recipe, including a hero image, title, 

metadata, and full instructions. 

• New artboard: press A > iPhone 8 > rename to 'detail' 

• Header with back button: reuse the header component (created from the overview header) — add a 

Material Icon text layer with chevron_left, font Material Icons, positioned inside the header 

• Space chevron: hold Alt to see spacing guides — match spacing on all sides (e.g. 14px each side) 

• Hero image: full-width rectangle at the top filled with Unsplash food photo 

• Gradient overlay on header: apply a linear gradient fill that fades from transparent to white/color so 

the header reads clearly over the image 

• Instructions text: use the Lorem Ipsum plugin to auto-generate filler text. Set font to Open Sans 

Regular, size ~15, increase line height for legibility 

• Detach component instance when you need full design freedom on a specific copy: right-click > 

Detach Instance 

  



SECTION 6: Components 

6.1 What are Components? 

Components are Figma's most powerful reuse feature. A Component is a reusable design element where 
one master copy (the Master Component) controls the appearance of all its duplicates (Instances). When 

you update the master, all instances update automatically. 

• Use case: a recipe list card used 5 times on the overview screen — update the font once on the 

master component and all five cards update 

• Master Component — indicated by a purple four-square icon in the Layers panel. The 'boss' — its 

properties cascade to all instances. 

• Instance — indicated by an empty (outlined) tilted square. Inherits master settings but can have 

individual overrides. 

 

6.2 Creating a Component 

• Select the element or group you want to turn into a component 

• Right-click > Create Component (or use the keyboard shortcut shown in the menu) 

• The element becomes purple — it is now the master component 

• Best practice: move the master component OFF the artboard. Store it in a separate area of the 

canvas so it does not appear in the final design. Copies of it (instances) are what you place on 

artboards. 

 

6.3 Creating Instances 

• Copy the master component (Cmd/Ctrl + C) and paste it onto the artboard (Cmd/Ctrl + V) 

• The pasted copy is an instance — it appears with the outlined tilted square icon 

• Instances look identical to the master but are separate placeable elements 

• Note: pasting may drop the instance directly on top of the master — it will appear in the Layers 

panel but seem invisible. Undo and move the master off-canvas first, then paste. 

 

6.4 Overriding Instance Properties 

Individual instances can have their own overridden properties while inheriting all other master settings. This 

allows different recipes to have different images and names while sharing the same layout.  

• Override a property: Cmd-click (or Ctrl-click) the specific layer inside the instance > make changes 

(e.g. change the text, swap the image) 

• Non-overridden properties: continue to follow the master component 

• Overridden properties: locked to the instance's custom value, not affected by future master changes 

• Reset Instance: right-click an instance > Reset Instance — removes all overrides and reverts the 

instance to match the master exactly 

• Example: change font color in master → updates ALL instances. Change font size in one instance 

→ only that instance changes (it has been overridden). 

 

 

 

 



6.5 Component Instances in Practice — Recipe App 

• The recipe list item was converted to a component 

• Three instances were placed on the overview screen — each with a unique food image (Unsplash) 

and a unique name (Lorem Ipsum plugin) 

• The header was converted to a component and reused on both the overview and detail screens 

• On the detail screen, the back button (chevron_left) was added to the header component instance 

— but only for the detail page version (using component override) 

• On the overview screen, the same header component instance had the back button text deleted via 

instance override 

 

6.6 Tidy Up — Auto-Aligning Lists of Components 

When you have multiple component instances (or any elements) in a list and they are not perfectly aligned, 

use the Tidy Up feature: 

• Select all the list items (Shift-click each, or click-drag to select all) 

• A blue 'Tidy Up' button appears in the selection — click it to automatically equalize spacing between 

all selected items 

• After tidying, use the horizontal center alignment button to ensure they are all centered on the same 

axis 

• Hover over the group selection — spacing dimensions appear. Click and type a new value to set 

exact spacing (e.g. 15px or 20px between items) 

• Pink circles appear between items — drag them to manually reorder items in the list 

  



SECTION 7: Prototyping — Interactions & Transitions 

7.1 What is Prototyping in Figma? 

Prototyping in Figma lets you link your screens together with transitions and interactions to create a 
clickable, navigable simulation of your app — without any code. Stakeholders and users can interact with it 

as if it were a real app. 

• Access: click the Prototype tab in the right panel 

• Launch: click the Play button (▶) in the top-right corner to open the prototype in a browser/preview 

window 

• The prototype displays inside an iPhone mockup frame to simulate real device experience 

• The mouse cursor becomes a large ball in preview mode 

• Press R in the preview window to restart the prototype from the beginning 

 

7.2 Creating a Basic Screen Transition 

• Select the source screen (e.g. Splash Screen) 

• Switch to the Prototype tab in the right panel 

• A blue connection ball appears on the edge of the screen — click and drag it to the destination 

screen (e.g. Overview) 

• Release on the target screen — a blue arrow connection line appears between the two 

• Default transition is 'On Tap' (user clicks/taps to navigate) 

 

7.3 Configuring Interaction Settings 

After creating a connection, configure the interaction behavior in the right Prototype panel: 

• Trigger: On Tap (user taps/clicks), After Delay (auto-advances after X milliseconds) 

• Action: Navigate To (go to a specific screen), Back (go to the previous screen) 

• Animation: Instant, Dissolve (fade), Push, Slide, Smart Animate 

• Easing: Ease In, Ease Out, Ease In & Out, Linear 

• Duration: set in milliseconds (e.g. 1000ms = 1 second) 

 

Splash screen configuration in the course: 

○ Trigger: After Delay — 1500ms 

○ Navigate to: Overview screen 

○ Animation: Dissolve (fade out/in) 

○ Easing: Ease In & Out 

○ Duration: 1000ms 

 

 

 

 

 

 

 

 



7.4 Component-Level Interactions 

Instead of setting a transition on every instance separately, you can define the interaction on the Master 

Component — all instances inherit it automatically. 

• Select the master component > Prototype tab > drag the connection ball to the detail screen 

• All instances of that component now have the same transition without any additional setup 

• IMPORTANT: this only works on instances that have not been individually overridden with their own 

transition settings 

• If instances already have custom transitions: right-click each instance > Reset Instance, then re-add 

images and names 

 

7.5 Back Button Navigation 

• The back button (chevron_left icon in the header component) should navigate the user back to the 

previous screen 

• Instead of linking to a specific screen, use the 'Back' action to always return to whichever page 

launched the current screen 

• Select the back arrow element > Prototype tab > drag the connection ball > connect to the blue 

'back' indicator 

• Since this is defined inside the master component, the back button works automatically on all 

screens using that component 

 

7.6 Smart Animate — Seamless Animated Transitions 

Smart Animate is a powerful animation type that detects matching layer names across two connected 
screens and smoothly animates the differences in their properties (position, size, color, etc.) creating a 

morphing transition effect. 

• Requirement: the layers that should animate MUST have identical names in both the source and 

destination screens 

• Set transition type to Smart Animate when connecting screens 

• Rename matching layers: e.g. rename the list item in both Overview and Detail to 'list item animate' 

— Figma animates between them 

• The animation morphs from the list card's position and size to the full -screen detail layout — 

creating a beautiful expansion effect 

• Duration: start at 500ms to see the animation clearly; tune down to 100ms for a fast, fluid feel  

• Speed tip: lower duration = faster and snappier animation; 100ms feels natural for list -to-detail 

transitions 

 

 

 

 

 

 

 

 

 

 



7.7 Scrollable Content 

When your design content is taller than the artboard (e.g. a long recipe list or long instructions text), you 

need to enable scrolling in the prototype. 

 

Enable vertical scrolling: 

○ Select the artboard/frame 

○ Prototype tab > Overflow Behavior > set to Vertical Scrolling 

○ Now the prototype allows the user to scroll down through all content 

 

Fix header while scrolling: 

○ Select the header layer (or any element that should stay fixed) 

○ Design tab > enable 'Fixed Position When Scrolling' 

○ The header now stays locked at the top while all other content scrolls beneath it 

○ In the Layers panel, fixed layers appear in a separate 'Fixed' subcategory within the frame 

 

• Apply scrolling to: Overview screen (recipe list), Detail screen (recipe instructions) 

• Apply fixed position to: the header component on both Overview and Detail screens 

  



SECTION 8: Key Shortcuts & Quick Reference 

8.1 Essential Keyboard Shortcuts 

Shortcut / Action Result / Description 

A Enter Frame/Artboard mode (click preset or drag to create) 

T Text tool — click for auto-size box, click-drag for fixed-width box 

R Rectangle tool 

O or E Ellipse/Circle tool (hold Shift while dragging for perfect circle) 

P Pen tool 

V Selection tool (default) 

Cmd/Ctrl + G Group selected layers 

Cmd/Ctrl + Shift + G Ungroup 

Cmd/Ctrl + R Rename selected layer 

Cmd + [ / Ctrl + [ Move layer backward (behind) 

Cmd + ] / Ctrl + ] Move layer forward (in front) 

Shift + Up/Down Arrow Increase/decrease font size by steps of 10 (text selected) 

Space + Drag Pan/navigate around the canvas 

Shift + Alt + Drag Resize while maintaining proportions and centre position 

R (in prototype preview) Restart the prototype from the beginning 

Left Arrow (in prototype 

preview) 
Go back to previous screen 

 

8.2 Workflow Checklist for Each New Screen 

• 1. Press A to create a new frame — choose iPhone 8 or drag custom size 

• 2. Rename the frame immediately (Cmd/Ctrl + R) 

• 3. Plan the layout based on your IA (what data goes on this screen?) 

• 4. Build the elements: header, content blocks, images, text, icons 

• 5. Use Material Icons (font family: Material Icons) for UI icons 

• 6. Use Unsplash plugin for placeholder photography 

• 7. Group related elements (Cmd/Ctrl + G) and name each group descriptively 

• 8. Convert reusable elements to Components (right-click > Create Component) 

• 9. Switch to Prototype tab and wire up screen transitions 

• 10. Enable Overflow Scrolling and Fixed Header settings as needed 

• 11. Set Smart Animate on matching-named layers for premium transitions 

• 12. Press ▶ Play to test the prototype — press R to restart 

 

 

 

 

 



8.3 Plugin Reference 

Plugin What It Does How to Access 

Unsplash Search and insert freely licensed, 
high-resolution photos into any 
selected shape 

Right-click layer > Plugins > Unsplash 
> search keyword 

Lorem Ipsum Auto-generate placeholder text to fill 
text layers 

Select text layer > right-click > Plugins 
> Lorem Ipsum > Auto Generate 

Material Icons Built-in icon font (not a plugin — it is a 
font family in Google Fonts) 

Text layer > font family > type 'Material 
Icons' > type icon name (e.g. 
access_time) 

 

— End of Course Notes — 


